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1. BRIEF INTRODUCTION

This guide was developed for a basic training in Geographic Information Systems (GIS),
to serve as a quick introduction to QGIS, which is the base software on which other
applications and plugins, relevant to Sustainable Land management and Land
Degradation Mapping, run, i.e: Trends.Earth (Conservation International) and
Watershed Tool (WOCAT). The document aims to convey basic applications offered by
this computer tool to produce practical knowledge, solve problems of georeferenced
information management and creation of maps. This manual has step-by-step
explanations of the practices carried out in the training to serve as a reference material.
However, it can also be used by those who want to venture into GIS (self-taught). Please
see the QGIS page for further practical and theoretical guidance with sample data and
examples:

https://www.qgis.org

2. INSTALLING QGIS

QGIS is an open source and free software that can be downloaded for every operating
system. It is distributed in both a Latest Release version, which has the most recent
developments and features and a Long-Term Release that is updated once a year, so it
remains stable for longer periods. Also, for windows users it is provided in the 32bit and
64bit versions according to your operating system.

Standalone installers from OSGeo4W packages A yc u3 OSGeodW

Latest release (richest on features): g Bepeus b

sy
& ( “\3 QGIS Standalone Installer Version 3.12 (64 bit) i q "& ABTOHOMHBI ycTaHOBIMK QGIS Bepcun 3.12 (64 bit)

sha256 sha256
=1

F Y ( %é QGIS Standalone Installer Version 3.12 (32 bit) & Q& ABTOHOMHBIV yCTaHOBWMK QGIS Bepcuu 3.12 (32 bit)
sha256 sha256

Long term release repository (most stable): Bepcun ¢ o a @ (caman crab

p
G =y
& ( ’*‘é QGIS Standalone Installer Version 3.10 (64 bit) & i '&é ABTOHOMHBIV yCTaHOBUMK QGIS Bepcuu 3.10 (64 bit)

sha256 sha256

= PN
& E:é QGIS Standalone Installer Version 3.10 (32 bit) i ﬁ \V& ABTOHOMHG I YCTaHOBUWMK QGIS Bepcyn 3.10 (32 bit)

sha2s6 sha256

To download the program, visit the web page and select your preferred option. To
choose 64-bit or 32-bit version you can check your operating systems first by pressing
the Windows key + Pause or going to Control panel - System.

Once the installer is downloaded, run it and follow the instructions to complete the
installation. When completed, a folder will appear on your desktop with all the
shortcuts, to start QGIS just double click on QGIS DESKTOP x.x.x with GRASS x.X.x .



3. INTERFACE

QGIS can be run from a User Interface (GUI) or command line and integrates tools from
other free and open systems like GRASS, GDAL, SAGA and programming languages like
Phyton and R. The GUI is has different components that can be re-arranged and

personalized. Basically the main QGIS GUI types of components are:

Menu Bar
Toolbars
Panels
Map View
Status Bar
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There are many Panels and Toolbars in QGIS that can be made visible and/or located in
different parts of the GUI Windows. Just try a right click on the menu bar (2) to see the

available ones.

Also in the Browser or Layer Panels (3) you can make a Right click on a file to access the

contextual menu that contains many options.



4. OPENING AND MANAGING VECTOR DATA - EXERCISE 1

4.1 Downloading and exploring the data

4.1.1 Please first download the Testing Dataset (QGIS_CACILM2_Exercisel.zip).

4.1.2 Please extract the data in a folder and explore to see few Shape files (*.shp) that
will be used in this demonstration.
Layers are a free open dataset for the whole world produced by OpenStreetMap (OSM)
https://www.openstreetmap.org. There are many ways to access and download data
from this repository, like external services (https://overpass-turbo.eu/ or
https://download.geofabrik.de/) or QGIS plugins like: OSMDownloader or QuickOSM.
The layers provided contain OSM data for:

e Tajikistan Border: Country limits

e Tajikistan Admin 4: Second administrative level boundaries (province)

e Tajikistan Admin 6: Third administrative level boundaries (district)

e Tajikistan Roads: Main roads
Tajikistan River: Main Rivers
Tajikistan Place: Populated places

There are many different options to open a File in QGIS:
Q
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e 1.-Using the Data Source Manager (Ctrl + L) to choose the type of File and specify
details.

e 2.- Using QGIS Browser and double clicking on the layer you want to open.

e 3.- My Favorite : Just Drag and Drop from your normal file explorer.

4.1.3 Please, open all the files provided to see their content in the Map View. By using
the QGIS Browser you can select all of them and open them all at once:



v a Exercise_QGIS_1
P Tajikistan_Admin_L4.shp
= Tajikistan_Admin_L6.shp
= Tajikistan_Border.shp

P Tajikistan_Place.shp
= Tajikistan_River.shp
P Tajikistan_Roads.shp

4 »

Layers A 2N @®
*‘/L@%YS“'?‘?‘Q W g
v [ Tajikistan Admin L4
v [ Tajikistan_Admin_L6
v [:] Tajikistan_Border Order of
v @ Tajikistan_Place appearance

v Tajikistan_River
v — Tajikistan_Roads

Toggle visibility

Here you have to consider a few things:
e The color of the layer is assigned randomly
e The order of appearance is from top to botton in the list, so if you have a
polygon with solid fill on top it will cover what is below.
e You can just drag and drop items in the list and toggle the visibility in order to
organize your view.

4.1.4 Play with the order and visibility to see the layers:
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v — Tajikistan_Roads Change the
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\ Change visibility




4.1.5 After exploring the structure of the open layers to know what type of vector file
we have in each case (point, line, polygon), we should proceed to explore what data we
have in the databases and what their representation system is. A lot of information and
functions can be obtained trough the Context Menu, by Right Clicking the name of the
layer:
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e A.- Context Menu: has many basic functions for the specific layer.
e B.- Open Attribute Table, will give us access to the database associated with the
Layer
e C.- Properties: Opens the layer Properties Menu: One of the most used functions
for Layer management. Here you can (and we will use it a lot):
- Check the layer information and Sources
- Change the Symbology
- Manage Labels
- Etc. etc.

4.1.6 Please explore the Attribute table of some of the Layers to we what’s in there.
And try some of this bottons, Specially the last one:

SO AP RPPRARR &



4.2 Changing Polygon Style

Our objective is to get this view:

8
®
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+ [ Exercise QGIS_1
= ™ Exercise_QGIS_lu
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STEPS:

Toggle the visibility off for all Layers except for the Tajikistan_Border.

Go to Layer Properties -> Symbology -> Click on Simple Fill (1), then click the arrow in
the Fill color bar (2) and when the Color windows opens, check the Box with Transparent
Fill (2). Then choose the color of outline in the Stroke Color bar (3) and set a width for
the line 0.86 (4) click Ok to see if it works (I Hope so).

) Layer Properties - Tajikistan_Border | Symbology X

= single symbol =
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v Enable symbol layer 451 Drowe effects Bick Coior
» Layer Rendering Choose Color...
Style OK Cancel Apply Help
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4.3 Styling Polygon by Categories in the data

Now let’s paint all the Tajikistan_Admin_L4 units with a different color:

™ Exercise QGIS_1u
3 Tajikistan_Admin_L4hp
3 Tajidstan_Admin L6sho
2 Tajikistan_Bordershp
& Wjikistan_Place.shp
G= Tajidstan_Riversnp
G Tajikistan_Roads.shp
+ [Iaals
v [ testlayers
& Evaluation of approaches for incorporati
E 1 of appraaches for incorparatin
NGIS 17in L

1]

& Tajlkdstan Admin L4

' [] Bunoary Mymops Kiuctons Baganuon
! Il Bancarm Cyra

v B BenoaTi Xatnon

v [ fywanse

! Il Hospmyon 10Bem symypit

+ [] Tafikistan Border

STEPS

Go to Layer Properties -> Symbology -> Choose Categorized (1), Then choose the Field
from the Attribute Table that you want to categorize (2 - “Name”) and press Classify (3)
to get all the possible values for that Field. You can apply different palettes like color
ramps for numerical values or Random color for cases like this with nominal categorical

values. You can also personalize the colors by clicking on each Symbol (4). Press Ok when
done to see the result.

() Layer Properties - Tajikistan_Admin_L4 | Symbology X

’ Categorized @ i
‘; Information Value | abe Name @ || £
J\Q\ Source Symbol ! v
" Symbology Color ramp | Random colors I

Symbol ¥ Value Legend

Vi B Bunosty Myxtopu Kyxucronn bagaxwon Bunoatd Myxtopu Kixuctonn bagaxwon

v | Bunostw Cyia Bunortk Cyra

v BuvnoaTk XataoH BunoRm XataoH

v [ Qywanse JOywarte
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Classify || | =3 || Delete Al Advanced ¥

b Layer Rendering
Style T oK Cancel Apply Help
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4.4 Styling Lines considering their type and hierarchy

Now it gets a bit trickier, for the Tajikistan_Roads, we would like to classify them and

assign different type of lines and colors according to hierarchy:

fi Information

A8 Source

Diagrams

." 3D View

ﬁ Fields

- Attributes
Form

Joins

Auxiliary
ﬁ Storage
@ Actions
- Display
. , Rendering

Variables

“ Metadata

E Dependencies

Legend

QGIS Server

! Categorized @ v
Value abe highway v||E
Symbol }'
Color ramp Random colors |~
Symbol ¥ Value Legend

/| w— trunk trunk

v primary primary Q Symbol Levels X

[ R secondary secondary @

PSS vV Enable symbol levels
@ Define the order in which the symbol layers are rendered.
The numbers in the cells define in which rendering pass the
layer will be drawn.
Layer 0 Layer 1
== trunk - () -2
—|secondary — 0
o —
< »
oK Cancel Help
Classify : & | = || Delete All @ Advanced ¥
» Layer Rendering
Style ¥ oK Cancel Apply Help

Go to Layer Properties -> Symbology -> Choose Categorized (A), Then choose the
Field from the Attribute Table that you want to categorize (B - “highway”) and press
Classify (C) to get all the possible values for that Field. Now it is time to choose the
Symbol for each class (D): Double click on the symbol near “trunk” and choose the
type of line. You can choose “topo main road” from the Favorites sections and set

Width to 1:

() Symbol Selector X
- i ot
— Llner , &
== Simple line =
== Simple line
Unit | Milimeters -
Opacity BT
Width | 1.00000 2 €L
<1, Favorites a~- | 2
[a
......
......
simple red line topo main road topo railway -
"= topo main road Save Symbal... | Advanced
oK Cancel Help
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For primary you can choose “topo road” also Width 1. And for Secondary just change
the color of the Simple Line to Brown and use a Width of 0.5.

Tajikistan Roads
| == trunk
| = primary
| — secondary

You can now press OK and see the result. But be aware that some issues arise. For
example, “secondary” roads might be on top of “trunk” road. We would like to make
sure that a priority order is followed and more important roads appear on top of other
with less hierarchy:

Also, if you use the Identify feature tool you will see that the Roads are made of
segments. Normally the joins are not visible if you use a Simple Line, like in
“secondary” road, but under composed lines (trunk and primary) it produces an effect
that we also want to correct:

¥
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For this please go back to Layer Properties -> Symbology -> Advance (E) -> and choose
Symbol levels... when the windows Pops-up (F) click on Enable symbol level. Please
complete the table as shown (F), the logic is to assign a higher number to higher
hierarchies. Once you are done press OK. If you want to save a style for later use, you
can click on Style (G) and choose Save Style.

The result should look something like this:

4.5 Points: Style, filter and Labels
Now if we toggle on visibility on the Tajikistan_Place Layer, lots of points should appear:

Use the Identify feature tool and Open the Attribute table to explore the data.
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According to the Attribute Table the total number of points in the layer is:

Q Tajikistan_Place :: Features Total: 1817, Filtered: 1817, Selected: 0

The field “place” in the database contains lots of different values, indicating the type of
settlement. If you want to get a report on all the possibilities, you can run this tool to make a

list: Vector -> Analysis Tools -> List Unique Values... and in the Target Field(s) Option choose:

“place”:

Total unique values: 15
Unique values:

e village
* plot

* country
e hamlet
e locality
* region
e jsolated dwelling
e borough
* town

* neighbourhood
® state

* city

e yes

o farm

e suburb

For our map we want to filter this layer in order to have only City and Towns:

® | .
Browser _B® (X Query Builder
s 220 4. Zoom to Layer
Favorites Zoom to Selection Set provider filter on Tajikistan_Place
» % Spatial Bookmarks O Show in Overview Fields Values
¥ F—._: ProjectHone Show Feature Count
» @8] Home Name 1 Search
» DIy Copy Layer admin_leve = =
» [ DA Rename Layer capital Icc_a“w
» TIEA . < - neighbourhood
L] Duplicate Layer int_name ;
» @ GeoPackage = arne e plot
P L4 Remove Layer... - region
f Spatialite name gl
@ rostGis "% Open Attribute Table o — state
P MssaL J Toggle Editing e suburb
— Eilt opulation Lo
@ DB2 Filter... prp village =
@ WMS/WMTS Change Data Source... wikidata
. wikipedia
v @ XVZ Tiles Set Layer Scale Visibility... p Sample All @
%" Bing maps addr_count i )
=5 Set CRS > Use unfiltered layer
" Bing Satélite
R DT e Export »
w Operators
LBYCF;L = e Styles
o | -, & v 0 1 .
Properties... = < > LIKE % N NOT IN
Tajikistan Place [ =
v @ borough <= >= I= ILIKE AND OR NOT
v @ city
v © country Provider specific filter expression
v @ farm
v/ ® hamlet = 'city' OR = "town|
v @ isolated_dwelling
v @ |ocality
v @ neighbourhood
v @ plot
v @ region
v © state
v @ suburb
v ® town L) »
v © village
v @ yes oK Test Clear Cancel Help
o @

For this please Right click on the Layer name (1) to get the Context Menu and choose
Filter... (2). This should Open the Query Builder: Choose the target field (3) “place” and
press All (4) to get the list of all values for this field. You can either write the Filter

15




expression below (6) or you can just Double click on Fields, Values and Operators (3, 4
, 5) and they will automatically be written below (6). Press OK when you are done.

If you check now the Attribute Table the total number of points in the layer should
have changed:

@ Tajikistan_Place :: Features Total: 108, Filtered: 108, Selected: 0

Let’s have some styling for these points. You can use the “topo pop capital” (5) size 3.2
for the Cities and for Towns just make the dot Black and size 1:

_—
@ Layer Properties - Tajikistan_Place | Syd (3 Symbol Selector hee
X Laye operuies - lajiKistan_rlace Y
F coegoeed (@) -
@ information YR be pl 7:® ‘ il
al
DaLe paci ‘ O Simple marker E
J\s\ Source Symbol — O n
& symbology Color ramp — ‘
a3 Labels Symbol ~ Value |
v @® city
D Masks v e town | unit | Milimeters -
o t ‘ [
Diagrams v all othel  opacity 1000% |5
Color l,
ny 3D View
Size 3.20000 s €
E Fields ;
Rotation | 0.00 © 2 €
Attributes
==l Form Q. Favorites a~ |8
Joins a
-~ Auxiliary
<™ Storage a @ ® @
@ Actions
WL
, Display shield disability topo hospital topo pop capital =
Classify | | &2 g |
& Rendering ) = Stue SymiaL)
VELELE Help
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Time to add some Labels for the points:

Q Layer Properties - Tajikistan_Place | Labels

9 @il Single Labels @ v ||%
(. -
2 Informa Value | abc Name @ Ml K

’)\:\‘ Source v Text Sample
¥ symbold L =
orem Ipsum
@be| |abels
Lorem Ipsum |49 |1:3184220 ¥ ||y v
abe Text Buffer

:*¢ Formatting | v/| Draw text buffer 4=,

A ~
s56 Mask Size 1.0000 v S

@ Background Millmeters €
</ Shadow
'/°° Callouts Color " =
Joirs # Placement Color buffer's fill
_/ Rendering — =
‘ Opacity 1000% |+ €L
E" Auxilia
Pen join style | B Round > | €
,~@ Actions
= Blend mode | Normal > | &
, L Draw effects
< »
= Style ~ OK ‘ Cancel Apply Help

In Layer Properties -> choose Labels (1) -> Choose Single Labels (2) and the field that
contains the text “Name” (3). There are many options for Labels to control how and
where text is added, for now we only add a Buffer (4) by checking the option Draw

text Buffer.
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It seems there are too many names in the map (2. But we can solve that:

(@ Layer Properties - Tajikistan_Place | Labels
Q (&% Rule-based Labeling @

Label Rule

Information

Source

Symbology

Q@ Edit Rule
Description  OnlyCity @
®) Filter | "place” = 'city'

Else  Catch-all for other features
Scale range

Minimum (exclusive) Maximum (inclusive)

|1:100000 v 1:1000
v Labels
VENS
Value ' abc Name ¥
Diagrams w Text Sample
- =
3D View Lorem Ipsum
Fields (X Expression String Builder X
. Expression | Function Editor @
Attributes :
Form =[+f-zf=0~0nlcl)iw DIB A Searc... | |Show Values| |group field =2
= ‘city'| > Aggregates Double-click to add field name to
Joi » Arays expression string.
oins » Color Right-Click on field name to open
» Conditionals context menu sample value loading
L Auxiliary > Conversions T
» Custom Notes
Storage » Date and Time e e o e |7
~ Fields and Values Vakme] Q. Search
Actions P -
abc Name All Unique 10 Samples
: abe admin._|... ity
Dusplay abe capital own
abe int_name
= abc name_en
Rendering abc name_ru
abc old_name
Variables s
abc populati...
- Output preview: 1
' M & ||/
etadata ok || cancel Help
Style ~ oK Cancel Apply Help

Dependencies
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We can choose to Label only certain type of points or use different styles for different
hierarchies. In Layer Properties -> choose Labels (1) -> Choose Rule-based Labeling (3)
and Double click on the first Rule (3) to enter Edit Rule. Enter a name in Description
(4) and define the Filter (5). You can either write or press the € button to open the
Expression Builder, this works similarly to the Query Builder we used before (try it!).
Then click the OK in all windows to get Labels only on the cities. In Rule-based Labeling
you can use the + button to set new rules for other types of points.

| hope you map looks cleaner and clearer now.... Lets prepare it for printing!!!

4.6 Preparing a Print Layout version of your map

In this section we aim at putting the map into a Page designer and export it from QGIS
in one of the many formats or send it to printing. So far, we have been working in the
Map Canvas and now we have to lay out items and release our creativity:

D D% 2N — , ! U
LA AN AN ‘

Browser
RESTYT*TO
v B E

» [ 7] O_borrar Enter a unique print layout title
(a title will be automatically generated if left empty)

4 Create print layout Title X

] Ayas

[ Bancos First_Map| @

"] Blancos

5 CACILM2

(] CBP

| ] Exercise_QG

3 Exercise_QG

» @ QgisEluy
CR Tajikistal
CR Tajikistal
CR Tajikistal
CR Tajikistal
CR Tajikistal  Open template directory | User Default
C Tajikistal

» [71.0GIS

oK Cancel

4 v »wv w

J

S v w

Show Duplicate.. Remove...

w New from Template

Empty layout v Create...

Close

First step is to open the Layout Manager (1), every page for printing that we create will
be here to view/edit. Being our first for this project, just create a Empty Layout (2).
When the windows pop-ups, just name the name of the print you are creating (3).

This will Open the Layout Editor in a separate window... it has so many options that is
scary!!! ...No worries, you will not suffer alone.
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If you place your Mouse on any on the icons you see and wait 1 second a small label

will tell you what is the name of that tool.

T
| Q First_ Map
‘Layout Edit View Items Add Item Atla@mgs
S BRI = Yy \
‘ﬁ s LRADR B ey e
4 3 bh

el

PN LN 20T | ST 12 YO O <2 1 [z [T 2=

b

N [N

Rems  Undo History
Items
@ @ lem

v I Map1

ayout Ttem Properties Guides

Item Properties
Map 1
CHEHR ER OB «

‘w Main Properties
Scale 3000000 @
Map rotation | 0.00 °

CRS Use Project CRS

V' Draw map canvas items

& o7 v layers
=0 |8
- | Follow map theme (none)
)
2
-3 2\ -
ﬁ— v Extents
F « > X min |273890.528
i
‘ x: 236,085 mm  y: 99.7846 mm  page: 1 58.5% v 4

The first tool we use is Add Map (1), and it will allow us to create an Item (2) where the
map (whatever is on your canvas) will appear. | made a rectangle almost the size of the
page (2), but you can choose your how section of the page to put the map.
Next is to move your map and adjust the zoom (scale), use the Move item content (3)
tool for moving things inside your square, or set a Scale manually (4). If you want to
move or resize the Item or select another item (after we add new ones) you need the
tool called Select/Move Item (5). The other Items we will create and use to make our
map are usually the ones in the red circle (6): Add Label, Add Legend, Add Scale Bar and

Add North Arrow. Every Item that we create will have an Item Properties Tab (7).

Let’s see the example of adding the Legend:

Unique values
Tajikistan_Place
® dty
* town
o

Tajikistan_River
Tajikistan_Roads
w— trunk

primary
=— secondary

O

B Tsjikistan_Admin_L6
Tajikistan_Admin_L4
[ Bunostu MyxTopu KyxucToru Bagaxw oH

Layout Item Properties
Item Properties
Legend

vV Resize to fit contents

v Legend Items

Auto update

E Unique values
» " Tajikistan_Place
Tajikistan_River
» /" Tajikistan_Roads
M Tajikistan_Admin_L6
» (9 Tajikistan_Admin_L4
[ ajikistan_Border

I BwiosTu Cyra

B BunosTH XaTnoH

[0 Aywarbe @

[ Hoxusxom Tobeu yymxypit =

£ Tajikistan_Bordes— 5 ViAld ®| =

Guides

©)

[ National Border

Settlements
© city
* town
Roads
o= trunk
primary
—— secondary
Administrative Units
7] BunosTn Myxtopu KyxuctoHu BagaxwoH
B Bunostv Cyrn
Bl BunosT XatnoH
[T Aywawnbe
[ Hoxmsxom ToBeu yymxypi
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First click on Add Legend (6) and choose a place to put the Item in the Page. It will
appear something like (A), where all the legends from all the layers appears. So, this
needs editing: for that you need to unclick Auto update (B) and using the tools in (C)
you can change any thing you like and delete all the ones that are not shown in the
map. Until you get something like the one in (D).

Please experiment by adding: 1.- North arrow, 2.- A title for the map (Add Label), 3.-
scale bar.

Once your map is ready, you can lock the Layers and styles of your Layout by clicking:
Lock layers and Lock Styles for layers as indicated in (8). Finally, you can export it to:

PDF, PNG, JPG, TIFF, SVG, etc. using one of the buttons in the top tool bar (9).

Here is my final map:

Exersice Number 1
This is the ugly map I prepared

[ national Border — Admiinistrative Units

Settlements [ Bunosmu MyxTopu Kixmcromn Bagaxuon
® dty [ Bunosmm Cysn

* town I BunosTy XatroH
Roads [ Ayuance

e trunk [ Hoxusxom ToBEM YyMXypH

= primary 0 75 150 km
— secondary L [—

21



4.7 Time to practice

use the river

Please now make your own map. You can also make a different zoom,
layer or District boundaries. Save your result as .png.

Here are some nice results from participants who took the training.
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— 00

Exercise Number 1
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5. QGIS BASICS 2: WORKING WITH DIGITAL ELEVATION MODELS
5.1 Introduction: Rater data & Digital Elevation Models

There are many sources and resolutions of Digital Elevation Models (DEM), and you
will have to choose depending on the use you want to make with these datasets.
Among the free options are:

e SRTM mission (NASA's Shuttle Radar Topography Mission), which covered the
whole world and many DEMs have been produced with resolutions ranging
from 30m to 1km.

e ALOS PALSAR produced global DEM at 30m and 12.5m resolution and
contains images of different years.

e ASTER Global also produced many different versions of a classic 30m DEM.

Most of these products are made by or with support of NASA and JAXA and can be
found in this repositories:

ASF Vertex:

https://search.asf.alaska.edu/#/

NASA

https://search.earthdata.nasa.gov/search

USGS

https://earthexplorer.usgs.gov/

One of the more classic interpretations of SRTM is the SRTM 90m Digital Elevation
Database v4.1 produced by CGIAR-CSI. More information about this product can be
found in their webpage (http://srtm.csi.cgiar.org/) and we will use this one for our
exercise. Downloads can be made from the page at either 5° or 30° Tiles.

We already provide in the course’s shared folder two of these tiles downloaded for our
Study area: srtm_50_05.tif and srtm_51_05.tif

© & srm.csicgiarorg/stmdata/ % e @ Ty

- @ Natural Resources and... [ Novaradio Citta Futur.. (= CE0 @ cEocev BY [ DigitaiSoiMapping # Scholar & (D FAOmail @) FAO Gateway D NASA-Webinar

FAv>
%'\';'}! SRTM Data FAQ Disclaimer Contact Us CGIAR CSI
a
Tile Size Format
© Tile 5x 5 degree © Geo TiFF

Tile 30 x 30 degree Esri ASCHI

contribuloss, CC.BY-SA, Imagers © Mapbox
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5.2 Opening and viewing the data set

First of all, please download and unzip the Exercise_QGIS_2.zip file in your working
folder.

Raster or Satellite images come in different resolutions in different tile or scene sizes
and in different reference systems. So, it is very important to learn how to use a tool to
stich neighboring images, change their projections and clip them to the study area.
Now we have our DEM from CGIAR and we will do exactly that.

Please Open in a new QGIS project the file Tajikistan_Admin_L4. Then Open the 2
SRTM files. We are going to work in the Khatlon Province in Tajikistan:

Tajikistan_Admin_L4 srtm_51_05

[ Bunostu Myxtopu Kyxucronm bagaxwor Il 610

[ Bunostv Cyen [ 17776 2 tiles
I BunosTH XaTnoH srtm_50_05

I nywan6e M 226

[ Hoxusxomn To6en Yymxypit [ 14997

Khatlon Province

As you can see these are separate images so we will need to find a tool to merge them
in order to cover the province with one image.
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5.3 Mosaic raster layers

To find the necessary tools, you first need to find the toolbox. You can Right Click in
any place on the toolbar (1) and when the panel option appears choose Processing
Toolbox Panel (2). This will open your Toolbox in a new Panel where you can simply
Browse or use the search bar to search for tools (3).

atabase Web Mesh Processing Help

{ Panels
Advanced Digitizing Panel = = »
' Browser (2) Panel Processing Toolbox @€
| v/ Browser Panel "A0OE R
GPS Information Panel Q. mosaic @ a

~ (D) Recently used

Layer Order Panel ;
& Mosaic raster layers

Layer Styling Panel - }é\c GRASS
V| Layers Panel ¥ Imagery (i.*)
¢ iimage.mosaic

Log Messages Panel
v & SAGA
OSM place search... Panel

¥ Raster tools
Overview Panel & Mosaic raster layers @

V| Processing Toolbox Panel @
Results Viewer Panel

Spatial Bookmark Manager Panel
Statistics Panel
Tile Scale Panel

Undo/Redo Panel
Toolbars

2 i B RSl N B SR e, T | B

The first tool we will use is one to stich the images together into a single mosaic. There
are few tools that do this in QGIS, we will try the one that comes from SAGA GIS.
Please search in the search bar (3) the word “mosaic” and find the “Mosaic raster
layers” tool indicated in (4) and Double Click to open it.
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(2 Mosaic Raster Layers @ %

Parameters Log

(2 Multiple selection X
Input Grids

—_——— {72 sitm_50_05 [EPSG:4326) Select Al
2 elements selecte v (2 ] srtm_51.05 (EPSG:4326]

Clear Selection
Name
Toggle Selection
Mosaic
Add File(s)...
Preferred data storage type
Add Directory...
[7] 4 byte floating point »

OK
Interpolation
Cancel

[0] Nearest Neighbor -
Overlapping Areas
[1] last -

Blending Distance

O

10.000000
Match

[0] none =
Output extent (xmin, xmax, ymin, ymax) [optional]
[Leave blank to use min covering extent

Cellsize

0.000833 @

Fit

[1] cells @ v

Grid

4

[Save to temporary file

V| Open output file after running algorithm =

0%

Run as Batch Process... Run Close

The tool (1) is very simple to use, just choose the Input grids by clicking in ... (2), then
in the new windows check the 2 SRTM tiles and click OK. We will need to specify the
pixel size of the output image (3) you can check in Properties -> Information the value
of the original tiles and paste it here (0.000833 for this case). Set Fit to “cells” (4). And
press Run to get a new file with both tiles merged. A new image called “Grid” should
have appeared. Sometimes an error message appears but do not worry, if the grid was
created, the process most probably worked well.

Every time you run a tool you will be producing a new raster file. So be aware that
large areas and file sizes duplicate every time you Run a process. In this last case we
didn’t select name and location of a file, so a temporary file was produced and if not
saved it will later be automatically erased when you close QGIS. Before saving it, we
will project the new grid in a plane and choose a coordinate system for that. The
downloaded images are in a geographic projection, where the units are degrees (EPSG:
4326) and we need to have both the vector layer (Tajikistan_Admin_L4) and the STRM
images with the same coordinate system to make operations among them.
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5.4 Reproject

Now that we have a single image for the whole area (called “grid” by default), we are
going to transform it into the coordinate system we have been using for the study
area: WGS 84/ UTM42N (EPSG: 32642).

For this we are going to use another tool “Warp (Reproject)” which comes from GDAL.
You can find it in the Toolbox as the previous time or in the top menu: Raster ->
Projections (1). Select the last image, “Grid” as the Input layer (2). The source
reference system (CRS) is optional but easy to fill (3), the target CRS is important so
please select or search (4) for EPSG:32642 or WGS84/UTM zone 42N. There are many
Resampling methods to use for this process, fell free to explore them, | selected
Bilinear (5) and | am quite happy with the result.

Points (6) and (7) in Advanced parameters are also optional. But if you would like to
save some Mb of storage you can choose High Compression (6) and Int16 (7) in the
case of this DEM. Please this time choose to “Save to File...” in the ... dots of step (8)
and save the result in your working folder with the file name of: “SRTM_UTM42N".

@ Warp (Reproject) X

BELGEY Database Web Mesh Processing Help

Parameters | Log

! ¥ Raster Calculator... 7o o a i e
Align Rasters... " ord [epscianzs] @ vl

A trends.earth

Analysis
Projections

Miscellaneous

& Assign Projection...

& Extract Projection...

Source CRS [optional]
T — @ - [

Targst CRS [optional]

EPSG:32642 - WGS 84 / UTM 20ne 42N

O,

Extraction

v v v Il v

Conversion

@ Warp (Reproject)...

Resamping method to use
Bilinear
Nedata valus for output bands [cptiond

Not set
Outtput file resclution in target georeferenced units [optional]
Not set

v Advanced parameters

Additional creation options [optional]

Profile | High Compression @ -
Name Value |~

1| COMPRESS DEFLATE

< 3

|| = Vaidate Help

utput data type

Int1 v

Georafersnced extents of output e to be crasted (xmin, xrsx, ynin, ymax) [options]

RS of the target raster extent [optional]

Use multihreaded warping implemantation
Additional command-kine parameters [optional]

N | Reprojected

/| Open cutput file sfter running sigorthm

GDAL/OGR cansole cal

0%

Run a5 Batch Process. Run Close Help

Great!! So far DEM tiles where downloaded, stitched and reprojected, it is time to cut
our region of interest. In this case the Khatlon Province.
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5.5 Cutting out the region of interest (Khatlon Province)

This requires we do 2 things:

First Select Tajikistan_Admin_L4 in the Layer Panel and then use the Select Features
tool from the Toolbar (1). Then you can click (2) on the Khatlon polygon (South East of
Tajikistan) to select it.

Sl By Db e e rotessing I Hidp @
SR ( O x ok = - O e (a
po-p OBIS a o & e - 8 - O = R

Once the province is selected, to extract the area of interest to a new image we will use
the “Clip Raster by Mask Layer...” tool (3). The input layer is our “SRTM_UTM42N” layer
we just created (4). We will cut that image using as mask the Tajikistan_Admin_L4 layer
(5). This will cut using all the Tajikistan provinces except we check the option “Selected
features only” (6), please do not forget to mark that! Please also check the “Match the
extent ...” box (7) in order to reduce the extent of the output layer. Steps (8) and (9) are
optional but will help with the file size (feel free to try). Please choose to “Save to File...”
in the ... dots of step (8) and save the result in your working folder with the file name of:
“DEM_Khatlon”.

a Database Web Mesh ng;essmg Help

L]
1 = Raster Calculator...

G Clip Raster by Mask Layer be

Paramaters | Log

S= | moutiayer
B® s uTmann [epseuzea] @ v (L,

Hask layer

3 Tagkistan_Admin_L4 [EPSG:32642] @ g Ll

W Selected features oniy
Source GRS [options]

Align Rasters...
A trends.earth
Analysis

Miscellaneous

- Target CRS [optional]
Extraction % Clip Raster by Extent... - [@
Conversion 4 ﬂ Clip Raster by Mask Layer... Assign 8 specfied nodat velue 1o output bencs [options]

et set

»
»
Projections »
»
»

Creata an output aipha band
/| Baich the extunt of the cipped raster to the xtent of the mask ayer

Keep resciution of input raster
Set cutput e rasolution
X Rasslution to sutput bands [sptional]
Not set
¥ Reschtion o oitput bands [options!]
Nt sat

w Advanced parameters
Use multthreaded warping implementation
‘Addtions craston options [eptnal]
 —
Name
1/ COMPRESS DEFLATE
4 »
P || == valdate Hep
Output dsta type

Iotg -
Addiional command-ine parameters [optonal]

Clpped (mask)
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Your result should look something like:

A

The result is not very appealing, but it will look better if we adjust the style. You can

1.8
also use the ~ ldentify feature tool to explore what data is stored in those pixels.

5.6 Styles for better visualization of a DEM

To change the style of a raster layer you have to also visit the Properties -> Symbology
menu that is found in the layer’s Context menu.

In Symbology (1) choose “Singleband Pseudocolor” in Render type (2). Then we will adjust the
minimum and maximum value we want to visualize in the palette in this case from 0 to 3600+
(3). Now is time to choose a nice color ramp, click on the arrow (4) to see more options, then
click on “Create New Color Ramp...” (5). A new window will open (6) please choose the “cpt-
city” palettes and press OK... yet other windows will open (7) and choose from the
“Topography” group the one called Wiki-scharzwald and press OK. Then please update the
values by pressing “Classify” (8) button.

For now, do not worry about the X and leave Blending mode in “Normal”, but
remember where the option is for later. Just click OK and let’s see the result.
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( Layer Properties - DEM_Khatlon | Symbology

2N

e
2 Information

‘{S\ Source

l‘i Transparency

u Histogram

4§ d Rendering
‘ Pyramids

! Metadata
»

Legend

QGIS Server

W Band Rendering

Render type | Singleband pseudocolor ¥

@

Band Band 1 (Gray)
Min 0 Max @ 3600
P Min / Max Value Settings
Interpolation Linear
ot e = o - @
Label unit Invert Color Ramp
. 1 Blues
Value Color 0 Greens

0 . A Greys (2 Color ramp type X

. Magma
1044.25 I | rdGy Please select color ramp type:
l Reds
Catalog: cpt-city v
2088.5 I | spectral
B viidis @ 1 = | -
313275 All Color Ramps ‘ P
Create New Color Ramp...
ar . Edit Color Ramp...
Save Color Ramp...

Mode | Continuous v Q@ Cpt-city Color Ramp

Blending mode | Normal

Zoomed: in | Nearest neighbour ¥

Ste v

=
O

v
oA
o %

¥ Strength ==

out | Nearest neighbour ¥

| 4 @ L -

Selections by theme
- * Selected palettes for topography (22)
reens
Greys l BN I :
» QGIS a3 garish14 20-3 cd-a db-a
Precipitation |
* Reds !
Temperature 02-a sd-a tv-a ws-a wt-a
et | ilm
Topography...
Top of the (c... 05250k-feet tpushuf pakistan wiki-knutux  wiki-schwar...
Top of the (s... [
* Transparency
- nwe -

Selection and Preview Information
mopil s i |K.-

Ucense  Creative commons attribution share-aike 3.0 unported (2012) [ hitp://creativecommons.org/licenses/by-sa/3.0/deec

Path wip/schwarzwald/wiki-schwarzwald-d050

Save 25 standard gradient oK Cancel Help

oK Apply Help

You should now see something like this:
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Let’s do a solid version too:

The solid version is called “Hillshade” and it is actually a rendering based in a light
source. The steps to build it are very simple:
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(@ Hillshade X
iENEd Database Web Mesh Processing Help
— Parameters Log
: !,: Raster Calculator... [10) 7~ ﬁ — = - O S <
Align Rasters...
AR = > 2" DEM_Khation [EPSG:32642) v
| A yends.carth FEHZOEEO 7
Band number
& Aspect
Band 1 (Gray) v
Projections » | &R Fill nodata... e e
r (v wm
Miscellaneous » H Grid (Moving Average)... 5 @ Q-
000000 -
Extraction 4 i:, Grid (Data Metrics)...
Scale (ratio of vertical units to horizontal)
Conversion 4 H Grid (Inverse Distance to a Power)... . -
.000000 <
H Grid (Nearest Neighbor)... it ot e it
/™ Hillshade... = 7~
000000 N
#+] Near Black... R @
1 Proximity (Raster Distance)... - =
& Roughness...
wu Sieve...
Use ZevenbergenThorne formula instead of the Horn's one
& Slope... e
) a Topographic Position Index (TPI)... e
uitidirectional shading

& Terrain Ruggedness Index (TRI)... S Abasdpa

Additional creation options [optional]
Profile ' Default v

Name Value

|| = Vaidate Help

Hilshade
E:/CACILM2/Excersice_QGIS_2/DEM_Khation_Hilshade.tf @ -

0% Cancel

Run as Batch Process. Run Close Help

Choose Hillshade Tool from the menu (1), use the DEM_Khatlon as Input Layer (2). One of the
parameters is the Z-Factor (3), this regulates the vertical exaggeration to make more evident
changes in the terrain, lets use 2 for this exercise. Other parameters are Azimuth and Altitude
(4) that simulate the location of the Sun in the sky, for example: Azimuth of 0 will be North and
Altitude of 90 is the Sun straight Up. Please choose to “Save to File...” in the ... dots of step (5)
and save the result in your working folder with the file name of: “DEM_Khatlon_Hillshade”.
Click Run and the new Layer should automatically appear.

Wouldn't it be fun to make a combination of this to maps? Merging the solid appearance of

the Hillshade with the colorful altitude of the DEM? Remember the X?

If you set the Blending Mode to Multiply in the DEM and put it on top of the Hillshade it
produces the combination. See:
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This is nice, but let’s do something more useful:

5.7 Making a Slope Map

BERG Database Web Mesh Progessing Help Q Slope X
- ll™ o~
1 "% Raster Calculator.. " @ - - B
Align Rasters... Pa & Lo
A trendsearth sy s pe
Projections » | d Fill nodata... y DEM, Khetion [Epsaiseee] @ X
Miscellaneous > h: Grid (Moving Average)... Band number
Extraction » i:, Grid (Data Metrics)... Band 1 (Gray) -
Conversion ¥ i-:, Grid (Inverse Distance to a Power)... R of vastical unids 8o fodt
ﬁ, Grid (Nearest Neighbor)... .
1.000000 v
@ Hillshade...
o] Near Black... Slope expressed as percent instead of degrees
7 Proximity (Raster Distance)... Compute edges
& Roughness... Use ZevenbergenThorne formula instead of the Horn's one
5 o
wu Sieve... - Al ire daes
& Topographic Position Index (TPI)... Additional creation options [optional]
ﬁ Terrain Ruggedness Index (TRI)... Profie | High Compression -
Name Value =
1/ COMPRESS DEFLATE
-
4 »
¥
/ & = Validate Help
Additional command-line parameters [optional]
Slope
E:/CACILM2/Excersice_QGIS_2/DEM_Khatlon_slope.tf @ p=
0% Cance
Run as Batch Process. . Run Close Help
Coordinate | 68.089,38.965 | R Scale 1:797762 ~ | {@ Magnifier| 100% 3 R

This is a very useful and easy to make map. Just open the Slope tool (1), set the DEM_Khatlon
as Input Layer and save it as: “DEM_Khatlon_slope”. This will get you a black and white map
with the Slope calculated in Degrees:
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We can also use a categorical classification with the following criteria:

Class  Class Description Degrees

1 Flat to Very gently sloping 0-2

2 Gently sloping 2-5

3 Sloping 5-10

4 Strongly sloping 10-15
5 Moderately steep 15-30
6 Steep 30-60
7 Very steep 60+

34



(2 Layer Properties - DEM_Khatlon_slope | Symbology

o}

P :
fz) Information

‘3&‘- Source

L@ Transparency
] Histogram
& Rendering
B Pyramids
n\ Metadata
Legend

QGIS Server

Stv-[e v_@

w Band Rendering

Render type | Singleband pseudocolor + @
Band Band 1 (Gray)

Min 2 Max

F Min / Max Value Settings

Interpolation @ Discrete
Color ramp -

Label upit
suffix

Value <= Color Label

15 10-1
30

. @
- £

ode | Equal interval =
Cacsfy | (0 ||== || o ||im| |

Clip out of range values

0K

20

Classes | 7

®

Apply

-

-
w

Help

In Symbology (1) choose “Singleband Pseudocolor” in Render type (2). Choose Discrete in
Interpolation (3), choose Equal Interval as Mode (4) and set Classes to 7 (5). Then use the

Double Click to start changing the values (6) using the criteria previously described in the table.

Remember that you can save the Style for latter use (7) before saving.

5.7 Bonus Track: 3D map view

If you still like to play a little bit, you can go to View -> New 3D Map View and play a bit with
that tool to make 3D representations. In the options make sure to indicate your DEM_Khatlon

as source of terrain:

(2 3D Configuration X
v Camera
Field of View ‘:45“ =]
w Terrain
Type | DEM (Raster layer) - |
Elevation 25" DEM_Khation - |
Vertical scale | 1.00 I
Tile resolution | 16 px I
Skirt height 10.0 map units I
Map theme | (none) |
b Terrain shading
w Lights
=
oK Cancel Jl;;.
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5.8 Aspect calculation

Aspect is a very important factor describing the slope orientation. This is of great
importance in many regions since light patterns or wind/humidity could be
correlated to a certain direction.

In Raster -> Analysis -> Aspect... you can run the process by adding the

“DEM_Khatlon” as Input layer (1). Save the result as “DEM_Khatlon_Aspect” (2). The
result should look like the map below.

Q@ Aspect

Parameters | Log
Input layer ‘
=" DEM_Khation [£PSG:32642) @
Band number
Band 1 (Gray)
Return trigoncmetric angle instead of azmuth
Return 0 for flat instead of -9999
Compute edges

Use ZevenbergenThorne formula instead of the Horn's one
p Advanced parameters

Aspect
E:/CACILM2/old/Excersice_QGIS_2/DEM_Khation_Aspect.tf @

Run as Batch Process... Run Close
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You can improve the visualization by adding ranges to the orientation:

Q Layer Properties - DEM_Khatlon_Aspect | Symbology

v Band Rendering

Band

Min

Interpolation
Color ramp
Label unit
suffix

Value <=

4s
135
225
315

360

Render type | Singleband pseudocolor ~

8and 1 (Gray)
45 Max 360

» Min / Max Value Settings

Discrete »
- —
Label -
Classes 5 3
FIEIL)
oK Cancel Apply Help

’
‘4

A

it

)

/i

:f
Y

1
J

|
]

Many times, it is useful to transfer these categories to the pixel values, this is called
Reclassification.

5.9. Raster Reclassification
In the Raster Menu, you can find the Raster calculator. This allows many different operations

at pixel level.

Q Raster Calculator

Raster Bands

DEM_Khatlon@1 @ &
DEM_Khatlon_Aspect@®1
DEM_Khatlon_Aspect_Category1@1
DEM_Khatlon_Aspect_Category@1
DEM_Khatlon_Hillshade@1
DEM_Khatlon_Slope@1
DEM_Khation_Slope_perc@1

Clipped (extent)@1

SRTM_UTM42N@1

Grid@1
Number of cells that drain through each ¢+
4 3
w Operators
+ * sqrt cos
- / = acos
< > = 1=
abs min max
Raster Calculator Expression

(("DEM_Rhatlon_Aspect@l"
+

(("DEM_Fhatlon Aspect@l”
+
(("DEM_Ehatlon_Aspect@1"
+

( ("DEM_Rhatlon Aspect@1"
+
("DEM_Ehatlon_Aspect@l™ > 315) *1
+

("DEM Khatlon Aspect@l™ < 0) vo|

Expression valid

X

Result Layer

Output layer I_Khatlon_Aspect_Category.tif €1

Output format GeoTIFF .

Selected Layer Extent

X min 391561.09646 +| X max 629797.43411 s

Y min 4086979.76811 :: Y max 4294260.15984 i

Columns | 3063 ¥ | Rows | 2665 s

Output CRS EPSG:32642 - WGS 84 f UTM ¥ | &

>= () AND ("DEM ERhatlon_ Aspect@l" <= 45)) *1

> 45) AND ("DEM_EKhatlon_Aspect@l" <= 135)) *2

> 135) AND ("DEM_FKhatlon_ Aspect@l" <= 225)) *3
> 225) AND ("DEM_FKhatlon_Aspect@l® <= 315)) *4
| oK Cancel Help

V| Add result to project

sin tan log10 (
asin atan in )
<= >= AND OR
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You can select any available Raster from the list (1) define the output layer (2) and use
different operators to build your expressions (3) that can be mathematical or logical. In this
case we use a combination of both.

Let’s see a hypothetical example:
(RasterLayer > 1) * 2

- Here what we mean is that if what is inside the brackets () is true, then it is replaced by 1.
In this case this means that if pixel values in RasterLayer are greater than 1 (and therefore the
statement is true) then the logic operatoris (1) *2=2

- on the contrary, if the statement inside brackets is false, it is replaced by 0. In this case it
means that if the value in the pixel is equal or smaller than 1 then (0) *2=0

So, we can use the same classification criteria for Aspect layer in order to create a categorical
Aspect using the following criteria:

Reclassification of aspect values:
North, 315-45 degrees;

East, 45-135 degrees;

South, 135-225 degrees;

West, 225-315 degrees

Sout

For this, you can copy and paste the following expressions in the Raster Calculation Expression:

(("DEM_Khatlon_Aspect@1" >= 0) AND ("DEM_Khatlon_Aspect@1" <= 45)) *1

+

(("DEM_Khatlon_Aspect@1" > 45) AND ("DEM_Khatlon_Aspect@1" <= 135)) *2
+

(("DEM_Khatlon_Aspect@1" > 135) AND ("DEM_Khatlon_Aspect@1" <= 225)) *3
+

(("DEM_Khatlon_Aspect@1" > 225) AND ("DEM_Khatlon_Aspect@1" <= 315)) *4
+

("DEM_Khatlon_Aspect@1" > 315) *1

+

("DEM_Khatlon_Aspect@1" < 0) *0

Please, save the result as “DEM_Khatlon_Aspect_Category”. Your new Layer should now have
only 5 values. You can use the following Unique values (1) styling criteria:
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w Band Rendering
@ \otormation
1
Rander type | Paletted/Unique values >
@
Source
W ot Band Band 1 (Gray) -
&' symbology Color ramp Random colors -
L Transparency Value Color Label
Histogram 0 NoData
" Rendering 1 . North
. Pyramids 2 East
l‘ Metadata
3 South
.
Legend
e 4 West
QGIS Server
|
|
— |
Classfy A | | = Delete AL - ‘

5.10 Watershed delineation

Watershed delineation is a process that yields a lot of different Layers and requires many
different tools. The tools also require several parameters that have to be finetuned with
observation, trial and error and criteria. So basically, you have to play around with it since
every place is different and there is no one solution that fits all cases.

G rill.dir X
- ) . .

Parameters | Log r.fill.dir

Elewation = Fit=rs and generates 2

T depressicniess elevabion
:l. DEM_Khatlon [EPSG:32642] b =) ayer 2nd = fiow direction
anyer fr:!" a3 gnnen

Output aspect direction format [optional] elevation raster yer.

grass bl

P Advanced parameters
Depressicnizss DEM

| E:/CACILMZ/ o/ Exccarsice QGIS._2/DEM_Khatlon_Depless.if

|

i) | Cance

Run as Bstch Procsss... | Run | Close Help

If you are not interested in water bodies (accumulation) and want to get a drainage network
that goes all the way out of your DEM, then you run a Fill tool to get rid of imperfections (pits
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and holes). You can run the r.fill.dir or any other that could generate depressionless Raster.
Please name it “DEM_Khatlon_Depless”.

The next tool will be r.watershed. Use as Elevation the DEM_Khatlon_Depless (1), set the

Minimum size of exterior watershed basin to 1000 (2). If you have memory available put some

to work (3) to speed up the process. Click the Enable Single Flow direction (4) to get
smoother results.

(@ rwatershed X
>
Parameters Log r.watershed
Elevation = Watershed basin analysis program
25" DEM_Khation_Depless [EPSG:32642] @ v

Locations of real depressions [optional]

Amount of overland flow per cell [optional]

Percent of disturbed land, for USLE [optional]

Terrain blocking overland surface flow, for USLE [optional]

Minimum size of exterior watershed basin [optional]

=
Maximum length of surface flow, for USLE [optional]
Not set =
Convergence factor for MFD (1-10) [optional]
s a S
Maximum memory & used with -m flag (in MB) [optional]
S O)
<4> V| Enable Single Flow Direction (D8) flow (default is Multiple Flow Direction)
Enable disk swap memory option (-m): Operation is slow
Allow only horizontal and vertical flow of water
Use posttive flow accumulation even for likely underestimates
Beautify flat areas =
0% Cancel
Run as Batch Process... Run Close Help

This tool will produce a lot of results, so explore and play with the colors to understand it:
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» P Stream segments
» ¥ Half-basins
» Vv ¥ Unique label for each watershed basin
~ V¥ Number of cells that drain through each cell
B <=-500
-500 - 500
Il 500 - 99999999999
? Stream power index a * tan(b)
}' Topographic index In(a / tan(b))
® Slope length and steepness (LS) factor for USLE
? Slope steepness (S) factor for USLE
¥ Drainage direction

v v v ww

If you decide you like the Basin delineation you see in the Raster “Unique label for each
watershed basin”, or that it has potential to be adapted you can convert it to Vector to
manage it better. We are interested in a basin that goes to the town of Buston, located south

of Muminabad, in the west of the Khatlon province.

Use the r.to.vect tool to transform that raster into a Polygon layer:

@ rtovect

Parameters Log

Inputrasbrhye;
2= Unique Isbel for each watershed basin [EPSG:32642]
Feature type
area
Name of attribute column to store value [optional]
|value
Smooth corners of area features
W/ | Use raster values as categories instead of unique sequence
Write raster values as z coordinate
Do not build vector topology
Do not create attribute table
w Advanced parameters

4

r.to.vect

-~
Converts a raster into a vector layer.

|Bun as Batch Process...

Then is easier to look in the resulting polygons and select the basins of interest (1), you can
then Export (2) and Save a new layer ( clicking the Option (3) Save only selected features) that
only contains polygons of the desired watersheds (4). Please Name it as “Buston_basin”
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(@ Save Vector Layer as... @

Format | ESRI Shapefile

File name | E:\CACILMZ\0ld\Excersice_QGIS_2\Buston_Basin.shp

Layer nome

s EPSG:32642 - WGS 84 / UTM zone 420
Encoding uTES
V' Save only delected features

v to export

Name  Type Replace with displayed values
Vifid  Integerss

Vicat Integer | UseRange

V| label String

V' Add saved fie to map oK Cancel

Q@ Dissolve X
| -
Parameters | Log Dissolve
Input layer This algorithm takes a vector layer and
5 w || oell combines their features into new features.
£ Buston_Basin (£PSG:32642] | | ? | One or more attributes can be specified to
dissolve features belonging to the same
Selected features ont ging
0 class (having the same value for the
Dissolve field(s) [optional] specified attributes), alternatively all
1| | features can be dissolved in a single one.
0 options selected ‘ =
C All output geometries will be converted to
Dissolved multi geometries. In case the input is a
'Exczrsice‘QGIS_ZIBuston‘Basin_DtssnMd.shpi | polygon layer, common boundaries of
adjacent polygons being dissolved will get
v Open output file after running algorithm erased.
0% ‘ Cancel
| Run as Batch Process... Run Close | Help

5.11 Alternative Basin delineation with output coordinate

Once you have performed the r.watershed tool you can also use the r.water.outlet tool. This
requires that on of the output raster layer called Drainage direction (1) and that you specify
the coordinates that you want to use for closing the Basin (2). It is recommended to choose
one point that falls on a river, you can use Stream segments or Number of cells that drain
through each cell to help you choose.

@ r.water.outlet
»
Parameters | Log r.water.outlet
Name of input raster map o Watershed basn creaton program.
2" Drainage direction (EPSG:32642) -
Coordinates of cutlet point

S$87829.476,4213626.948 [EPSG:32642]

p Advanced parameters

-
‘ 0% Cancel
Run as Batch Process. Run | Close Help
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6.10 Do it yourself!
Now it is time to make a nice printed map with the DEM and/or the Slope. Here are

some of the results from the participants:

Map2 Khatlon DEM with Hillshade (Gulniso)

ex2 DEM with Hillshade (Pariso) A Standan .

= £:BAO Slope

ation_Hilishade
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6. XYZ TILES

Wouldn't it be cool to have in our projects background maps and images? Like Google Satellite

or Google Maps:

ins Vector Raster Database Web Mesh Progessing Help

n oo = = 2 : B 0 . e
PLRIPPRALBLERD 0o Clm-P T B
h om— .
- CVT-PEYY X : - o G G
e
Sﬂ"ﬂmw
©
Ury: o
N L . 5
m
Shehrisabz
o
Yokkabog
=]
Bey
™
\
S
K |_‘f.w =
i ey
{ oy
I‘ Shetab
| m
/ Talagh
et
| Termer
B T
Marwan
Q i Gak i
R
by N e
Mazar Sharif (unduz

o
ey Jlse

‘s

Mithan et

. a iy
Coordinate| 3520534039208 | R Scale 1:2123899 ~ | @ Magnifier 100% $

Then XYZ Tiles is your best option. Go to the Browser and Right Click for New Connection (1):

Browser om |
QYT ™®TO |

= ID teamviewer.txt =
(R ID teamviewer.txt
» @ GeoPackage
/ Spatialite l
@ rostGis
P MssaL
@ Oracle
& ps2 |
& WMS/WMTS
2 XYZ Tiles

=" Bing New Connection...
" Bing Sf Save Connections...
=* CARTO .
%* Carto F‘ Load Connections...
=" ESRI National Geographic |
=" ESRI Physical -
< o >

(2 XYZ Connection >4

Connection Details

Name @ Google Hybrid
URL https://mt1.google.com/vt/lyrs=y8x={x}&y={y}8z={z}
Authentication

Configurations Basic

Choose or create an authentication configuration

&

Configurations store encrypted credentials in the QGIS authentication database.

No authentication ¥

V| Min. Zoom Level [0 |*

v Max. Zoom Level 18

Referer

Tile luti Unk (not scaled) ¥

Cancel

Then you simply need to give it a Name and the URL of the background map (2).

44



Here is a list of URL to load many different ones that you can use, once you press ok it will be

available for you every time you open QGIS.

Google Maps: https://mtl.google.com/vt/lyrs=r&x={x} &y={y} &z={z}

Google

Satellite: http://www.google.cn/maps/vt?lyrs=s@189&gl=cn&x={x} &y={y} &z
={z}

Google Hybrid: https://mtl.google.com/vt/lyrs=y&x={x} &y={y} &z={z}
Google Terrain: https://mtl.google.com/vt/lyrs=t&x={x} &y={y} &z={z}
Google Traffic:
https://mtl.google.com/vt?lyrs=h@159000000,traffic|seconds _into week:-
1&style=3&x={x}&y={y} &z={z}

Google Roads: https://mtl.google.com/vt/lyrs=h&x={x}&y={y} &z={z}
OpenStreetMap: http://a.tile.openstreetmap.org/{z}/{x}/{y}.png
OpenStreetMap Mapnick: http://tile.openstreetmap.org/{z}/{x}/{y}.png
OSM Cycle Map: http://tile.thunderforest.com/cycle/{z}/{x}/{y}.png

OSM Black and White: http://tiles.wmflabs.org/bw-mapnik/{z}/{x}/{y}.png
OSM2World/3: http://tiles.osm2world.org/osm/pngtiles/n/{z}/{x}/{y}.png
Bing maps:
http://ecn.dynamic.t0.tiles.virtualearth.net/comp/CompositionHandler/ {q } 7mkt=
en-us&it=G,VE,BX,L,LA&shading=hill

Bing Satélite: http://ecn.t3.tiles.virtualearth.net/tiles/a{q} .jpeg?g=0&dir=dir_n’
ESRI Imagery/Satellite:
https://server.arcgisonline.com/ArcGIS/rest/services/World Imagery/MapServer
/tile/{z}/{y}/{x}

ESRI National Geographic:
http://services.arcgisonline.com/ArcGIS/rest/services/NatGeo World Map/Map
Server/tile/{z}/{y}/{x}

ESRI Physical:
https://server.arcgisonline.com/ArcGIS/rest/services/World_Physical Map/Map
Server/tile/{z}/{y}/{x}

ESRI Streets:
https://server.arcgisonline.com/ArcGIS/rest/services/World _Street Map/MapSer
ver/tile/{z}/{y}/{x}

ESRI Terrain:

https://server.arcgisonline.com/ArcGIS/rest/services/World Terrain_Base/MapS
erver/tile/{z}/{y}/{x}

ESRI Topo:
https://server.arcgisonline.com/ArcGIS/rest/services/World Topo Map/MapSer
ver/tile/{z}/{y}/{x}

ESRI Transportation:
https://server.arcgisonline.com/ArcGIS/rest/services/Reference/World Transpor
tation/MapServer/tile/{z}/{y}/{x}

Stamen Terrain: http://a.tile.stamen.com/terrain/{z}/{x}/{y}.png

Stamen Toner: http://tile.stamen.com/toner/{z}/{x}/{y}.png

Stamen Watercolor: http://tile.stamen.com/watercolor/{z}/{x}/{y}.jpg
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7. DOWNLOADING OPEN STREET MAP DATA

The original site is https://www.openstreetmap.org/

You can only download small section but there are many sites that will provide an access to
the OSM data.

GEOFABRIK

This site stores data at Continental level and Country level. Data can be downloaded in pbf
and shp formats, both can be opened in QGIS.

Link: https://download.geofabrik.de/

https://download.geofabrik.de/asia.html

OSMaxx

This is short for "OpenStreetMap Arbitrary Excerpt Export" https://osmaxx.hsr.ch/

You can select whole countries or personal regions. You can also choose different output
formats, like:

e Esri File Geodatabase
e Esri Shapefile
e GeoPackage
e Spatialite
e Garmin navigation & map data
e OSM Protocolbuffer Binary Format
And allows for different coordinate systems conversion too.

OVERPASS

This site let’s you use an API to place queries and make personalized filter. You can either use
the Wizard or write your own Query.

The Link is: https://overpass-turbo.eu/

Here some examples of How it works:
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Run  Share Export Wizard Save Load Settings  Help Overpass turbo o

@

Get boundary of admin lewvels by country

=/
[out:json][timecut:251;
1/ gather results
(
areal'name:en'="Kyrgyzstan']ladmin_level=2][boundary=administrative]->.myarea;
19 rel(area.myarea)[admin_level=4][boundary=administrative];

Large amounts of data x

out skel gt;

This query returned quite a lot of data (approx
3 MB}

Your browser may have a hard time trying fo
render this. Do you really want te continue?

abert continue anyway @

Run Share Export Wizard Save Load Settings Help Overpass tufbo L+,

@ Export X

~ Data |

Get boundary of admin levels

json][ti £:251;
[w ]5’::‘“ ]:":H:u ! download/copy as GeoJSON
(

area[ ‘name:en'="Kyrgyzstan' download/copy as GFX @ ;
rel{area.myarea)[admin_level=

¥: download/copy as KML

ody;

|ﬂ

nioad/copy as raw OSM data

out
25

out skel qt; raw data directly from Overpass API %

load data into an OSM editor JOSM
Levelo ¢

» Map

» Query

done

Paste the example scripts in the window and change the name of the country and admin_level
is required, then click on RUN (1) and when the windows appear (2) choose Continue anyway.
Once you see the result on the map, clik Export (3) and choose the type of file (4) KML is
usually the smallest file size and GeoJSON is the other option that open directly in QGIS with
Drag and Drop.

Here are some examples:

1) Administrative limits by country. Change ‘name:en’ with you country name. Change

admin level: 4-provinces, 6-Districs
/*
Get boundary of admin levels by country
*
/
[out:json][timeout:25];
// gather results
(

area['name:en'='Kyrgyzstan'][admin_level=2][boundary=administrative]->.myarea;
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rel(area.myarea)[admin_level=4][boundary=administrative];
);

// print results

out body;

>;

out skel qt;

2) Get all the roads in a country. Change ‘name:en’ with you country name.

[out:json][timeout:25];

// gather results

(
area['name:en'='Tajikistan'][admin_level=2][boundary=administrative]->.myarea;

way(area.myarea) ["highway"];

);

// print results

out body;

>;

out skel gt;

3) Get only some types of roads in a country. Change ‘name:en’ with you country name. Add or

remove types in RED.

[out:json][timeout:25];
// gather results
(
area['name:en'='Tajikistan'][admin_level=2][boundary=administrative]->.myarea;
way(area.myarea) ["highway"~"*(motorway|trunk| primary|secondary)s$"];
);
out body;
>;

out skel qt;

3) Get Places for a country. Change ‘name:en’ with you country name.

[out:json][timeout:25];

(
area['name:en'='Tajikistan'][admin_level=2][boundary=administrative]->.myarea;
node(area.myarea) ["place"];

);

out body;

>;

out skel gt;
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8. ADDITIONAL TRAINING MATERIAL BASED ON QUESTIONS

This material was prepared based on the questions from participants:
Is it possible to get polygon’s latitude and longitude?
Also would be better to get list of latitude and longitudes of these borders

8.1 Getting the centroids and coordinates for a polygon.
To get the centroids you can use the tool called “Centroids”

@ Centroids X

Parameters | Log Centroids

Input layer This algorithm creates a new point layer,

CQTajikistan Admin_L4 [EPSG:32642] ¥ || = || D with points representing the centroid of
= = : the geometries in an input layer.

Selected features only The attributes associated to each point in

the output layer are the same ones

Create centroid for each part @. associated to the original features.

Centroids

[Create temporary layer]

V' Open output file after running algorithm

0% Cancel

Run as Batch Process... \ Run l Close Help

And to calculate the coordinates of each point you can use the tool

( Add X/Y Fields to Layer X
Ll
Parameters | Log Add X/Y fields to layer
Input layer Adds X and Y (or latitude/longitude) fields
°® 2 i i to a point layer. The X/Y fields can be
iCootokis EFSC 120421 it 2 calculated in a different CRS to the layer
Selected features only (e.g. creating latitude/longitude fields for a
layer in a project CRS).
Coordinate oystem ( Added fields = Features Total: S, Filtered: 5, Selected: 0 e o X
EPSG:4326 - WGS 84 v ||® / e % LY ®® S PE S -
: name_yi name_yo name_zh x y
Field preﬁx [optlonal] 1 NULL 701429024877 389057475102
21 NuLL NULL 728674080552 38.0981102525
Added fields 3 N NuLL 692143939311 397970850121
[Create temporary layer] 4nwn Dushanbe Hmp 688045103537 38.5434506865
s UL UL 691447543618 37.8342668561
v Open output file after running algorithm
‘ »
Y Show Al Features, =M
{ 0% Cancel
Run as Batch Process... Run | Close Help
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This will produce another Point Shapefile with additional columns for X and Y at the

end. You can also choose the coordinate system for these columns, | normally use

WGS84 for this one.

If you want you can add this information back into your polygon by making Joins:

QlLa

',i Information
{:\\ Source

¥ Symbology
Labels
€O Masks

'I Diagrams

W@ 3D View

i rieios

Attributes Form
.‘ Joins

ﬁ Auxiliary Storage
[._Q Actions

- Display

& Rendering

Variables

l‘ Metadata

™ Dependencies

Legend

Setting

Value

(2 Add Vector Join

Join layer
Join field

Target field

Dynamic form
> Editable join layer
¥ V Joined Fields

name_vi

name_war

name_yi

name_yo

name_zh
v X

\ly@

point |

®

v Cache join layer in virtual memory

Create attribute index on join field

w V/ Custom Field Name Prefix

" Added fields -
abe_id -

abe _id v

0K Cancel

oK Cancel

Apply

Help

Here you just go back to the polygon layer and in Properties -> Joins (1) you can click
the + (2) to add new information. Simply choose the Layer and the Fields for matching

(3) then select what Fields you want to add to your polygon attributes (4) and the
Prefix if you like.

Note: this Join is not changing your original Shp database, it only happens for this
project. If you want to make it permanent you need to Export to a new Shp Layer.

T

TR

o e e

Alternative: Also, you can add directly a new field to your original Layer by going to the
attribute table and using the Field Calculator... see next page:
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o ®
= € “a VB S P E = B e
i
i Name id 1S03166_2 addr_provi admin_leve boundai
31|Bunoatu XataoH (2 Field Calculator
1
I2 Hoxwaxowm Tobe. Only update 0 selected features
13| Bunosu MyxTo. v Create a new field Update existing field
{a|Bunosmu cyea Create virtual field @
Output field name | Longitude
5 Aywarte Output field type | Decimal number (real) v
Output field length | 10 S Precision |3 —
Expression Function Editor
=+ = L=~ C)) [ i) x a Help function x =

54

i ¥ Show All Featurg
nfo
nin L4

x{centroid($geometry )j

®

Output preview: 518354.66364385973

.y

be turned on.

oriented_bbox *

$x
X
$x_at
X_max
X_min
y_max
v Maps
map_exist
v Math

Returns the x coordinate of a point
geometry, or the x-coordinate of the
centroid for a non-point geometry.

X (geom)

geom a geometry

You are editing information on this layer but the layer is currently not in edit mode. If you click OK, edit mode will automatically

OK Cancel Help

In the Context Menu, Open the attribute table and choose the Field Calculator (1),
then you can decide Name and type of Data (2) and write the formula (3) in this case:

x(centroid(Sgeometry)) 2 Meaning for every geometry take the centroid and get the

X

xX(centroid( transform( $Sgeometry,'EPSG:32642','EPSG:4326'))) 2> same but in WGS84

degree

Sarea = get the area of every geometry (in m2)

Sarea /1000000 -> Same but in Km2

Sperimeter 2 The perimeter of the geometry (in m)
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